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Chapter 1
AN INTRODUCTION TO AXN

Axon is Curtiss Wright’s next generation data acquisition platform. Axon is designed to be a future proof, flexible,
and reliable platform. Whether in use on commercial aircraft, military platforms, missile systems or space
programs, Axon is designed for the most demanding Flight Test Instrumentation (FTI) applications. 
The Axon product family consists of AXN and ADAU, equivalent designs tailored to fit the Acra and TTC networked
systems requirements respectively.
AXN is colored orange and black, in keeping with the Acra KAM-500 look and feel and is supported in DAS Studio
3 software. It offers output formats in line with the KAM-500 such as iNET-X and IENA and expands the Acra
offering by bringing IRIG-106 Ch10 UDP format support.
ADAU is colored grey, in keeping with the MnACQ look and feel and is supported in TTCWare software. It offers
output formats in line with the TTC networked products such as DARv3 and IRIG-106 Ch10 UDP format support.
(TmNS will be supported in the future.)

Figure 1: AXN and ADAU 9 user-slot chassis

Regardless of the platform, flight test programs commonly face the following challenges:
• Ensuring all data is captured

• Compressed time scales for test campaigns

• Instrumentation system installation challenges

• Dealing with new acquisition requirements

• Adding measurements in the middle of the campaign

• Handling increased data requirements

• Costly custom systems specific to a campaign need to be reused

AXN is perfectly suited to meet all these challenges; it is reliable, flexible, and designed for harsh locations, while
its optimal size and weight are perfect for locations with limited space.
AXN is offered in four sizes, with other options available on request.
• 16 user-slots (55 mm x 76 mm x 333 mm/2.16 in. x 3 in. x 13.1 in.)

• 9 user-slots (55 mm x 76 mm x 236 mm/2.16 in. x 3 in. x 9.3 in.)

• 6 user-slots (55 mm x 76 mm x 194 mm/2.16 in. x 3 in. x 7.63 in.)

• 3 user-slots (55 mm x 76 mm x 152 mm/2.16 in. x 3 in. x 5.98 in.)
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NOTE:  Above measurements may be rounded and are not inclusive of power connector height. Refer to the 
respective chassis data sheet for comprehensive measurements including equivalents in inches.

Figure 2: AXN chassis from 16 user-slot to single-slot Axonite

The design of the AXN allows for any combination of 2U to 16U chassis to be created, in any configuration
including circular chassis for rotor systems.
From the flexibility point of view, AXN is a solid modular chassis, making it easy to add new modules or replace
existing modules without having to dissemble the chassis. AXN modules are designed to be in-service
programmable, so they can be updated with new revisions of firmware in-situ, saving the need to return modules
for updating.
The AXN backplane, is a 1-Gbps point-to-point link for each module. This, while offering a significant increase in
bandwidth available over the backplane, offers the ability to extend the backplane outside the chassis to a single
user-slot chassis that can be placed in restricted places, closer to sensors. These single user-slot chassis are
called Axonites. Axonites can be placed up to 10 meters (33 feet) from the chassis and are powered by the chassis
through a 6-wire interface to the backplane via an extender card placed in the user-slot of the chassis. The 6-wire
cable consists of 2 x TX, 2 x Rx and 2 x power wires. Axonites can house any AXN user module and offer greater
heat dissipation in hot zones due to the greater relative surface area for the module to dissipate heat. 

Figure 3: Axonite single user-slot chassis

AXN reliability is guaranteed by building on the heritage of Curtiss-Wright’s Aerospace Instrumentation group. The
Aerospace Instrumentation group is the number 1 provider of FTI worldwide. AXN uses FPGA-based state
machine acquisition engines. These are live at power up, immediately acquiring data after power interrupts.
System wide synchronous sampling is guaranteed across the AXN product line. All parameters are sampled at the
start of the acquisition cycle and then at evenly spaced intervals throughout the cycle. Analog acquisition is
accurate up to 0.02% FSR. Channel density is maintained or increased even with the reduced size of AXN. 
As the Axon product family is the next generation data acquisition platform from Curtiss-Wright, it has been
designed from the start to be future proof. This is achieved by using a serial backplane with dedicated 1 Gbps links
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to all user module slots. The controller acts as an aggregator to collect data from all slots and is the current limiting
factor of the available bandwidth.

Figure 4: Dedicated 1 Gbps links to all user-slots

The controller has dual 1000BT outputs initially providing 23 Msps (380 Mbps) of bandwidth to the AXN, which
comfortably exceeds current Flight Test requirements. To meet future demands for increased bandwidth for FTI
programs, it will only be necessary to upgrade the controller. This will allow for newer high-speed modules to be
installed while still supporting existing modules.

About this AXN Quick Start Kit User Guide
The AXN Quick Start Kit User Guide is intended for engineers who need to set up and evaluate an AXN system.

Unpacking and checking the contents
Remove all contents from the package and confirm that the following items are included:
• AXN/CHS/09U – 9 user-slot Axon chassis containing the following modules:

-  Slot 0: AXN/BCU/40x – Axon backplane controller

-  Slot 1: AXN/ABM/401 – Axon 24 channel ARINC-429 bus monitor/packetizer

-  Slot 4: AXN/EXT/401 – Axon extender module

-  Slot 8: AXN/ADC/401 – The 8 channel flexible analog module

• AXN/ITE/01U – Remote Axonite housing

• 1 meter Axonite-to-Extender module cable (AXN/CAB/001/01M)

• Laptop (with power adapter and cable) preconfigured with DAS Studio 3 software

Controller

ACQ
MODULE 1

ACQ
MODULE 2

ACQ
MODULE 3

ACQ
MODULE 14

ACQ
MODULE 15

.

.

.

Dedicated full-duplex 1G Serial link

1G Ethernet
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• Chassis power cable (CON/PSU/008/FLG/100)

• BCU-to-dual RJ-45 cable (AXN/CAB/002)

• 1 meter RJ-45 Ethernet cable (CAB/NET/007)

• Axon module removal tool (ACC/TOL/041)

• USB-to-RJ-45 Ethernet connector

• Mating connectors and pins to assemble Axon user module interface cables (CON/KAD/002/CP)

Inspect all contents for any visible signs of damage that may have occurred during transit. If damaged, contact
Curtiss-Wright support (acra-support@curtisswright.com). Keep the packing material in case you need to return
the product or ship it to another location.

WARNING: Always ensure that proper ElectroStatic Discharge (ESD) precautions are in place before handling or
storing Curtiss-Wright equipment. See the Axon Handling Precautions document.

Registering for technical updates
Curtiss Wright issues a monthly bulletin, which provides updates on software versions and documentation
changes. To register for this bulletin, contact Curtiss Wright support (acra-support@curtisswright.com).

Getting help and support
Visit www.cwc-ae.com for further information about the company’s products and for resources such as FAQ,
technical notes and tutorials.
Please provide details of any hardware or software problems you have to acra-support@curtisswright.com

www.acracontrol.com
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Chapter 2
HANDLING GUIDELINES FOR AXN MODULES

NOTE:  Illustrations used in this section are of AXN products; ADAU products are identical in structure and form 
factor.

Basic handling guidelines
Before proceeding, you should read the Axon Handling Precautions document. This document covers electrostatic
considerations, module screw torque settings, and detailed instructions for inserting and removing modules in a
chassis.

The Axon product family chassis major component parts
As shown in the following figure, the Axon product family chassis consists of a power supply unit, high-speed
backplane, and the single piece milled AXN box.

Figure 5: Major components of Axon product family chassis 

Axonite
The Axonite is a 1 user-slot remote chassis that allows any AXN user module to be placed up to 10 meters (33
feet) from the chassis. It offers better heat dissipation for hot zones and is designed to fit into compact spaces. 

The power supply is qualified 
to MIL-STD-704 and capable of 
providing up to 100W of power 
to the backplaneThe high-speed 

backplane is a point-to-
point LVDS design, 
allowing over 1 Gbps 
of data from each slot 
independently

The Axon product family 
box is milled from a 
single piece of aluminum 
and qualified to DO-
160G
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Figure 6: Axonite 1 user-slot remote chassis

Axon product family chassis slot numberings
The Axon chassis is a solid modular chassis with up to 16 user-slots. The chassis consists of a single piece milled
chassis box, backplane, and Power Supply Unit (PSU).The AXN backplane controller module ships already
installed in slot 0 of the chassis. For all chassis, user-slots are numbered in ascending order starting with slot 1
next to the backplane controller (slot 0). The following figure shows slot numbering for a 16U chassis.

Figure 7: 16U chassis slot numbering

As shown in the following figure, each slot has grooves into which the guide rails on the module slot into, ensuring
the module is correctly inserted.

Slot 0: BCU PSUSlots 1 to 16
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Figure 8: User-slot PCB guide-rails grooves

Using the Axonite
The Axonite (AXN/ITE/01U) is utilized by first installing the extender card into the Axon chassis and then connecting
the Axonite to the extender card with the supplied cable.

Connecting the Axonite to the chassis
1. Disconnect the power cable from the chassis.

2. Insert the extender card (AXN/EXT/401) into the chassis. (Refer to the Axon Handling Precautions document.)

3. Connect the Axonite cable (AXN/CAB/001/01M) backshell to the extender card top block.

4. Tighten the screws to torque 0.6 Nm (0.44 foot pound-force).

Guide-rail 
grooves

Bore holes for 
module screws
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5. There is a white alignment dot on the Axonite connector and a corresponding white dot on the cable connector.
Ensure the dots are aligned and then connect the cable to the Axonite.

6. Power on the chassis.
The power LED on the Axonite lights.

Disconnecting the Axonite from the chassis
1. Disconnect the power cable from the chassis.

2. Confirm the power LED on the Axonite is off.

White 
alignment 
dots

Power 
LED on

Power 
LED off
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3. Keep the alignment dots aligned and disconnect the cable connector.

Grounding the AXN chassis

Star point
The star point is a common point for all grounds on the aircraft or vehicle. It is the designated reference point for all
voltages and signals.

NOTE:  Due to the low impedance of most aircraft structures, the star point can be the whole airframe.

AXN isolated grounds
The AXN has the following three grounds:
• GND: AXN internal electrical ground
• CHASSIS: AXN mechanical ground
• POWER(-): 28V return

NOTE:  All three grounds are isolated from one another inside the AXN. CHASSIS is the signal name to differenti-
ate it from the physical AXN chassis (metal work).

GND
GND is the zero volt line that all AXN internal signal conditioning modules use. All input and output signals on AXN
modules are referenced to this potential. This signal point is normally taken out to the connector on the top of each
AXN module (if available) and is usually pin 51. The GND point is also available on the AXN Power Supply Unit
(PSU) connectors.

CHASSIS
Each AXN module also has a CHASSIS pin available; this pin is connected to the AXN chassis. The signal is taken
out to the connector on the top of each AXN module (if relevant). The ground mounting bolt on the top of the PSU
is also connected to this signal point and to the chassis.

POWER(-)
POWER(-) is the return line for the AXN power supply. 

NOTE:  The POWER(-) pin is not connected to the CHASSIS line or GND line within the AXN.
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AXN grounding
Each isolated ground signal should be connected to the main star point on the aircraft or vehicle using a low
impedance connection. 
Hence the GND pins on the AXN PSU connector, and the POWER (-) pin on the PSU connector should be
connected directly to the star point. 
It is acceptable to use the ground mounting bolt on the PSU instead of the CHASSIS pin. 
A common cable should not be used to take more than one of these signals to the star point.

NOTE:  When more than one AXN is used, each AXN should be connected to the star point using individual cables. 
Shared cables should not be used.

Figure 9: Axon product family grounding

Figure 10: Grounding for multiple chassis

Validating grounding
After connecting the grounds, measure the resistance between each GND point, CHASSIS point and POWER (-)
on each AXN to the star point. The resistance should be below 50 mΩ.
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Cables and shielding
All cables should be shielded and the shields connected to the AXN through the connector backshells. If the
backshells have shield terminations then use these, otherwise bend the shields back and clamp them under the
cable clamp. The alternative method is to use a short pig-tail and take this to the CHASSIS pin on the AXN
connector. This method is acceptable but it is not the preferred method as it may result in a short length of
unscreened signal cable.
Signal cable shields should ideally only terminate at the AXN end. Bus cables may terminate at both ends as
stated in the relevant bus specification document.

Figure 11: Shielding

Curtiss-Wright recommends the use of twisted pairs with an overall foil shield. Wires should ideally be silver plated.
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Incorrect configurations

Incorrect AXN grounding
Any two or all three of the ground station signals should not share a common cable to the star point as shown in
the following two figures.

Figure 12: POWER(-) return and GND using the same ground

Figure 13: POWER(-) return, CHASSIS, and GND using the same ground
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Incorrect star grounding for multiple chassis
If multiple AXNs are used, then all ground signals should be taken back to the star point and no two chassis should
share common cables for the GND, POWER(-) or CHASSIS signals.

Figure 14: Example of incorrectly connecting the GND signals of two chassis

Connecting the laptop to the AXN chassis and logging in
1. Power on the laptop. 

2. At the log in screen, type QuickStartKit and then press Enter.

3. Connect the USB-to-RJ45 Ethernet connector to one of the USB ports on the laptop.
The Ethernet connection appears as Ethernet 2 on the Laptop, pre-configured to IP address 192.168.28.100.

4. Connect the AXN BCU-to-dual RJ-45 cable (AXN/CON/002) to the BCU in slot 0 of the chassis and then 
tighten the thumbscrews to 0.6 Nm (0.44 foot pound-force) torque.

5. Connect one end of the Ethernet cable (AXN/CON/007) to the RJ45 adapter on the BCU; connect the other 
end to the RJ45 adapter on the laptop.

6. Connect the power cable (CON/PSU/008/FL/100) to the chassis PSU connector; connect the other end to a 
power supply (red connector positive, black negative) set to 28V at 5 amps minimum.

7. Turn on the power supply.
The PSU LED on the AXN chassis lights green and the Ethernet connection from chassis to laptop activates.

8. Test the connection by opening a command window on the laptop (Start/CMD) and type ping 192.168.28.1 
and then press Enter.



This page is intentionally blank
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Chapter 3
CONFIGURING THE AXN SYSTEM

Configuring the AXN system with DAS Studio 3
DAS Studio 3 is the Curtiss-Wright configuration software for Acra KAM-500 and AXN based systems. For more
information on using the software, see the DAS Studio 3 User Manual document
(DAS_Studio_3_User_Manual.pdf) on the desktop.

Automatic discovery of AXN
Discover is used to build a system configuration by detecting existing Curtiss-Wright hardware. Detected hardware
is analyzed and a XidML task file is generated with default hardware settings and parameters.
1. Open DAS Studio 3 from the desktop.

A new XidML® 3.0 file named NewConfiguration.xidml is automatically created.

2. On the File menu, click Discover.

3. In the Hardware Discovery dialog box, select IP Address, then right-click and select Add. 

4. In the From and To fields of the Add Ethernet Gateway dialog box, type the factory default IP address 
192.168.28.1 and then click Add.
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5. Click Run Discovery.

When Discovery is complete the following message appears.
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6. Click OK to return to the Hardware Discovery window.
Discovered hardware is listed in the Status Information pane.

7. Click Save File to save the configuration file.

The following section describes manually creating the same configuration task that we used Discover to create in
this section. You can skip the following section and go to “Configuring the Axon controller” on page 23.
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Manually creating a task file
You may need to manually create a configuration task file, for example, if hardware is not yet available.
The AXN Quick Start Kit ships with the following hardware configuration. 
• AXN/CHS/09U – 9 user-slot Axon chassis containing the following modules:

-  Slot 0: AXN/BCU/40x – Axon backplane controller

-  Slot 1: AXN/ABM/401 – Axon 24 channel ARINC-429 bus monitor/packetizer

-  Slot 4: AXN/EXT/401 – Axon extender module

-  Slot 8: AXN/ADC/401 – The 8 channel flexible analog module

Refer to the following to manually create a task file that matches the factory-shipped hardware configuration. In the
following example, an AXN/BCU/401 controller is shown in the screen shots for illustration. You should choose the
appropriate AXN/BCU/40x controller you wish to use/configure.
1. On the File menu, click New.

2. Click the Click here to begin button in the Navigator.
Navigator Editor tabs
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Instruments Palette opens.

3. On the DAU tab, select MyAXN_CHS_09U and click Add.
The overview node and the chassis are added in the Navigator.

Slot 0 is the backplane controller (AXN/BCU/40x) slot; only the AXN bus controller can be added to this slot.

Overview node
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4. Double-click slot 0.
Instruments Palette opens.

5. On the Ethernet tab, select MyAXN_BCU_401 and click Add.
The backplane controller (MyAXN_BCU_401) is added in the Navigator.
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6. Double-click slot 1.
Instruments Palette opens.

7. On the Bus Monitor tab, select MyAXN_ABM_401 and click Add.
The ARINC bus monitor (MyAXN_ABM_401) is added in the Navigator.

When shipped, the AXN extender card (AXN/EXT/401) is installed in slot 4 of the actual chassis hardware.
However, the extender card—and the Axonite chassis (AXN/ITE/01U) that connects to it—are transparent to the
software. Therefore, they are not added to the configuration file. When you install a user module in the Axonite, it is
shown in the software as though it were installed directly in slot 4 of the chassis. See “Installing the Axonite” on
page 57.
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8. Double-click slot 8.
Instruments Palette opens.

9. On the Analog tab, select MyAXN_ADC_401 and click Add.
The AXN flexible analog module (MyAXN_ADC_401) is added in the Navigator.

10. On the File menu, click Save As, choose a location and file name and then click Save,



CHAPTER 3: CONFIGURING THE AXN SYSTEM 23

 

The task file is renamed appropriately.

Configuring the Axon controller
The AXN backplane controller (AXN/BCU/40x), is the controller of all traffic flowing across the AXN backplane. It
ensures all modules in the chassis are programmed correctly and aggregates data from all AXN user modules in
the chassis, transmitting the data over its dual 1000BT Ethernet ports. It acts as a time master of all modules in the
chassis, taking time from IEEE 1588 PTPv1 or PTPv2 Grandmaster and synchronizing all user modules in the
chassis. It is also capable of acting as a PTPv1 or v2 Grandmaster itself, synchronizing other DAUs in the system
to the correct time. It also contains a Linux based operating system allowing all modules in the chassis to be
configured over a web interface.



24    AXN Quick Start Kit User Guide (BK/0045 | 9 Aug. 2021)

3

 

To view settings for the AXN/BCU/40x module, select the module in the Navigator and then click the Settings tab. 

The following table describes the parameters on the AXN/BCU/40x Settings tab.

Parameter Type/Name Description

Report
P_MyAXN_BCU_401_Report

Contains bits showing PTP synchronization status, Ethernet link status of 
both ports, Health bits of the AXN/BCU/40x process and Event triggers. See 
the data sheet for details.

ReadCounter
P_MyAXN_BCU_401_Read-
Counter

This parameter is a test register that increments every time it is read.

PTPTime
P_MyAXN_BCU_401_PTP-
Time

PTP time is available over 3 parameters. By default the full PTP time is avail-
able from P_MyAXN_BCU_401_PTPTime.This is a 64-bit parameter where 
the top 32 bits indicate the number of seconds since 1st Jan 1970 and the 
lower 32 bits indicate the nanosecond count of that second, as per the PTP 
protocol. 
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The AXN backplane controller also monitors the status of the chassis backplane and PSU as well as its own
temperature. This information is indicated through the following parameters.

The IP address of the AXN/BCU/40x is identical on both ports. The current IP address setting is shown in this field.

PTPTime : PTPSeconds This 64-bit parameter can be broken into two separate 32-bit parameters: 
PTPTime : PTPSeconds and PTPTime : PTPNanoSeconds. 
To create these parameters click the drop-down arrow on each empty field 
and then select Add new parameter.

A new parameter is created for each.
PTPTime : PTPNanoSeconds

ChassisStatus
P_MyAXN_BCU_401_Chas-
sisStatus

This parameter reflects the status of the chassis that the AXN/BCU/40x is 
controlling. See the data sheet for details.

EthernetStatus
P_MyAXN_BCU_401_Ether-
netStatus

This parameter indicates the status of both Ethernet ports. See the data sheet 
for details.

Parameter Type/Name Description

BackplaneVoltage
P_MyAXN_BCU_401_Back-
planeVoltage

This parameter indicates the current level of the 15V backplane voltage.

BackplaneMasterCurrent
P_MyAXN_BCU_401_Back-
planeMasterCurrent

This parameter indicates the current draw of the master DC-DC converter on 
the PSU.

BackplaneSlaveCurrent
P_MyAXN_BCU_401_Back-
planeSlaveCurrent

This parameter indicates the current draw of the slave DC-DC converter on 
the PSU.

PSUTemperature
P_MyAXN_BCU_401_PSUTe-
mperature

This parameter indicates the current temperature of the PSU.

ControllerTemperature
P_MyAXN_BCU_401_Control-
lerTemperature

This parameter indicates the temperature of the AXN/BCU/40x motherboard.

Parameter Type/Name Description
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NOTE:  This field is only for editing the IP address of the AXN/BCU/40x in the configuration task file. To change the 
IP address of the hardware itself, you must use the IP Address tool (see “Setting the IP address of the AXN 
controller” on page 57). Once you have changed the physical IP address, then you edit this field to match.

The port speed of each Ethernet interface can be set to 100BASE-TX or Autonegotiate (recommended setting).

As the AXN/BCU/40x contains an Ethernet switch core, the ability to block traffic coming in on one port from going
out on the other port can be set by enabling the Block Traffic From Other Port setting.

Be default any Ethernet packets generated by the AXN/BCU/40x, or any user modules in the same chassis, are
transmitted out of both ports simultaneously. To restrict chassis traffic to only come out of one of the ports, enable
the Block Traffic From Chassis setting on that port.

The AXN/BCU/40x has a 1 Pulse Per Second TTL output on pin 1 of the top block (see the data sheet). This can
be used for debugging or system commissioning purposes to check the synchronization between multiple chassis.
This output can be enabled by checking the PPS Enable setting.

The AXN/BCU/40x time behavior can be controlled via the time PTPv1 and PTPv2 settings.
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The Synchronization Level is the number of nanoseconds delta from the PTP grandmaster to the AXN/BCU/40x’s
notion of PTP time; above this setting the AXN/BCU/40x considers itself out of PTP sync and indicates this in the
Report parameter. The Synchronization Level range is from 500 to 10000 ns.

Setting the PTP mode
The AXN/BCU/40x supports the following PTP protocols in both client and Grandmaster modes:
• PTPv1 

• PTPv2 end-to-end mode 

• PTPv2 peer-to-peer mode 

Setting the AXN/BCU/40x as a PTPv1 client

1. Set the PTP protocol to PTPv1.

 

2. Select the PTPv1 Subdomain.

3. Set the PTPv1 Sync Interval.
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As the AXN/BCU/40x can synchronize over either Ethernet port, there could be multiple PTP Grandmaster’s
available to the AXN/BCU/40x to sync to. When the AXN/BCU/40x is acting as a PTPv1 client, the PTPv1
Preferred Grandmaster setting should be enabled. This tells the AXN/BCU/40x to synchronize to the preferred
PTP Grandmaster.

Setting the AXN/BCU/40x as a PTPv1 Grandmaster

1. Set the PTP Protocol to PTPv1.

2. Enable PTP Grandmaster. 

3. Configure the PTPv1 settings above as required.

When acting as a PTPv1 Grandmaster, with the Preferred Grandmaster enabled, the AXN/BCU/40x PTPv1 sync
messages will have the Preferred Grandmaster bit set.

Setting the AXN/BCU/40x as a PTPv2 end-to-end client

1. Set the PTP Protocol to PTPv2 Delay Req.

2. Set the PTPv2 Subdomain to the required value (0 - 255).

 

3. Set the PTPv2 Announce Interval to match the announce interval of the PTPv2 Grandmaster.
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4. Set the PTPv2 Sync Interval to match the Sync interval of your PTPv2 Grandmaster.

5. Set the PTPv2 Priority to match the Priority setting of your PTPv2 Grandmaster.

Setting the AXN/BCU/40x as a PTPv2 peer-to-peer client

1. Set the PTP Protocol to PTPv2 Delay P2P.

2. Set the PTPv2 Subdomain to the required value (0 - 255).

 

3. Set the PTPv2 Announce Interval to match the announce interval of the PTPv2 Grandmaster.
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4. Set the PTPv2 Sync Interval to match the Sync interval of your PTPv2 Grandmaster.

5. Set the PTPv2 Priority to match the Priority setting of your PTPv2 Grandmaster.

Setting the AXN/BCU/40x to act as a PTPv2 Grandmaster in end-to-end or peer-to-peer modes

To set up the AXN/BCU/40x as a PTPv2 Grandmaster in either end-to-end or peer-to-peer modes, set the PTP
protocol to the desired PTPv2 version and enable the PTP Grandmaster. Setup the PTPv2 settings as required
above.

For sampling and packaging data, see “Creating packets and sampling data” on page 58.
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Configuring the AXN AXN/ADC/401
The 8 channel flexible analog module, AXN/ADC/401, supplied with the AXN Quick Start Kit is a powerful and
flexible analog module. Each channel can be individually configured to act as differential ended, single ended, full-
bridge, half-bridge (potentiometer), thermocouple, RTD 2/4 wire, RTD 3 Wire, AC coupled or ICP input.
Independent voltage or current excitation per channel is supported. Each channel on the AXN/ADC/401 has three
filter tap points. Each filter tap point can be individually configured with its own Filter Cutoff and Filtering Mode.
Linearization to standard thermocouple or RTD types are supported as are user-defined linearization tables per
channel. Cold junction compensation for thermocouple channels are supported. Shunt and bridge completion
resistors per channel are on board. Fast balancing of analog channels are supported. 
This section explains the major features of the module and how to configure it for each setting type.
To view settings for the AXN/ADC/401, select the module in the Navigator and then click the Settings tab.

The BalanceStatus parameter, P_MyAXN_ADC_401_BalanceStatus, indicates the status of each channel with
relation to its balance settings and balance operation.

The ReadCounter0 parameter, P_MyAXN_ADC_401_ReadCounter(0), is a test register that increments every time
it is read.
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The parameter P_MyAXN_ADC_401_Top-blockTemperature indicates the temperature of the built in temperature
sensor on the top-block of the module. This can be used as a cold junction for thermocouple sensor operation (see
“Configuring the AXN/ADC/401 for thermocouple inputs” on page 39).
The parameter P_MyAXN_ADC_401_ModuleTemperature indicates the temperature of the built in temperature
sensor on the module motherboard. This can be used as a reference temperature for customer defined
linearization tables (see “Configuring the AXN/ADC/401 for thermocouple inputs” on page 39).
Each channel has three filter tap parameters that can be sampled separately. The operating range for the channel
is applied to all filter tap points and is set by defining the range on filter tap point 0 for each channel.

The range value is dependent on the input mode selected. For differential ended, single ended, full-bridge, half-
bridge, AC coupled, and ICP modes the range is in volts and limited to +/-10V.
For Thermocouple and RTD modes, the range is in Celsius and limited to -270 ºC to +2320 ºC for Thermocouple
mode and -200 ºC to 660 ºC for RTD modes. 
The input mode for each channel is set by selecting from the drop-down list in the Input Mode column.

Defining Filter Mode and Filter Cutoff for Input Modes
For each filter tap point per channel, you can define the Filter Mode applied to each filter tap point independently.

FIR applies a Kaiser window Beta = 6, 49-tap FIR filter.
IIR8 applies an 8th order Butterworth IIR filter.
IIR16 applies a 16th order Butterworth IIR filter.
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For each filter tap point per channel, you can define the filter cutoff applied to each filter tap point independently.

Setting Excitation Mode
Excitation Mode can be independently set for each channel to either Current or Voltage excitation.

Excitation Amplitude is in volts for Voltage excitation and is limited to 0V to 10.2V. Excitation is unipolar on the
AXN/ADC/401. For example, to set 5V excitation current, set the Excitation Mode to Voltage and Excitation
Amplitude to 5.
The Excitation Amplitude is in amps for Current excitation and is limited to 0 mA to 32 mA. For example, to set
2 mA excitation current, set the Excitation Mode to Current and Excitation Amplitude to 0.002.
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Linearization URL settings
The Linearization URL setting is required for thermocouple and RTD modes. See “Configuring the AXN/ADC/401
for thermocouple inputs” on page 39 for details.
Junction Compensation Channel, User Compensation URL, and User Compensation Channel are explained in
“Configuring the AXN/ADC/401 for thermocouple inputs” on page 39.

Balancing analog channels
The AXN/ADC/401 supports fast balancing of analog channels. This is explained in “Balancing analog channels
using Bridge Balancer” on page 67. The settings for balance, defining the balance target and the balance range is
done in DAS Studio 3 and programmed into the module.
For each channel users must set Balance Options. The choices are: 
None – Balance is not allowed on this channel; previously applied balance is removed. 
Lock previous – Prevents new balance values from being applied; locks balance correction applied from previous
runs.
Allowed – Balance adjustments may be applied to this channel; overwrites previous adjustment values.
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Maximum Balance defines the required headroom to be applied on top of the user-specified range for each
channel. The setup software sets instrumentation amplifier gain to allow for the required headroom. Ensure you do
not define a maximum balance that pushes the channel outside the range of the instrumentation amplifier. The
Maximum Balance unit is input mode dependent; it is expressed in volts for differential ended, single ended, full-
bridge, half-bridge, AC coupled, and ICP modes. For Thermocouple and RTD modes, the range is in Celsius.
Balance Target defines the value the balance process attempts to adjust the channel counts to match. The
Balance Target unit is input mode dependent, it is expressed in volts for differential ended, single ended, full-
bridge, half-bridge, AC coupled and ICP modes. For Thermocouple and RTD modes the range is in Celsius.

Enabling/disabling shunt resistors
The AXN/ADC/401 supports shunt resistors per channel. These are 100 kΩ resistors that can be switches between
analog+ inputs and ground. These resistors are classically used to test bridge operations pre-flight, but may also
be used for ground reference when the input to the module channel is isolated from the module ground.

Configuring the AXN/ADC/401 for differential ended inputs
1. Set the channel range to cover the range of the measurement you want.

NOTE:  This applies to all filter tap points for that channel.
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2. Set channel Input Mode to Differential ended voltage.

3. Configure Filter Mode and Filter Cutoff for each filter tap point. (See “Defining Filter Mode and Filter Cutoff for 
Input Modes” on page 32.)

4. Set Excitation Mode to Voltage or Current and set Excitation Amplitude as required. (See “Setting 
Excitation Mode” on page 33.) 

5. If the differential source is isolated from the chassis ground, set Classic Shunt on that channel to Enabled.

Configuring the AXN/ADC/401 for single ended inputs
1. Set the channel range to cover the range of the measurement you want. 

NOTE:  This applies to all filter tap points for that channel.
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2. Set channel Input Mode to Single ended voltage.

3. Configure Filter Mode and Filter Cutoff for each filter tap point. (See “Defining Filter Mode and Filter Cutoff for 
Input Modes” on page 32.)

4. Set Excitation to Voltage or Current and set Excitation Amplitude as required. (See “Setting Excitation 
Mode” on page 33.)

Configuring the AXN/ADC/401 for full-bridge inputs
1. Set the channel range to cover the range of the measurement you want.

NOTE:  This applies to all filter tap points for that channel.

2. Set the channel Input Mode to Full-bridge.
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3. Set Excitation to either Voltage or Current and set the required Excitation Amplitude.

4. Configure Filter Mode and Filter Cutoff for each filter tap point. (See “Defining Filter Mode and Filter Cutoff for 
Input Modes” on page 32.)

Configuring the AXN/ADC/401 for half-bridge or potentiometer inputs
1. Set the channel range to cover the range of the measurement you want.

NOTE:  This applies to all filter tap points for that channel.

2. Set the channel Input Mode to Half-bridge.

NOTE:  In Half-bridge mode, the module automatically switches to internal 100 kΩ completion resistors. Half-
bridge mode is also the correct operation mode for potentiometer measurements.
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3. Set Excitation Mode to either Voltage or Current and set the required Excitation Amplitude.

4. Configure Filter Mode and Filter Cutoff for each filter tap point. (See “Defining Filter Mode and Filter Cutoff for 
Input Modes” on page 32.)

Configuring the AXN/ADC/401 for thermocouple inputs
1. Set the channel Input Mode to Thermocouple.

2. Configure Filter Mode and Filter Cutoff for each filter tap point. (See “Defining Filter Mode and Filter Cutoff for 
Input Modes” on page 32.)
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3. Set Excitation Amplitude to 0.

4. On the Linearization URL setting for that channel, click the drop-down arrow and select Add full path.

5. Browse to the location of the thermocouple lookup files, select a file and then click Open.
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6. On the channel Range settings, set the Range Maximum and Range Minimum to the required range for that 
thermocouple type.In this example for a K-type thermocouple, max/min settings would be +1370 ºC to -270 ºC.

7. Thermocouples require a cold junction reference.which can be configured in one of the following two ways: 
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 •  Use the built-in, top-block sensor on the AXN/ADC/401 module by selecting it from the drop-down list of the 
Junction Compensation Channel. 

 •  Configure one of the other channels to be a PT-100 RTD sensor, by selecting the channel required and 
configuring it to RTD 2/4 Wire as shown below, using a range of +125 ºC to -55 ºC. (See “Configuring the 
AXN/ADC/401 for RTD 2/4 wire inputs or RTD 3 wire inputs” on page 43.)
Then set Classic Shunt for this channel to Enabled.

To use a non-standard custom linearization file, select the custom file and its compensation channel using the User
Compensation URL and User Compensation Channel settings similar to the above.
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Configuring the AXN/ADC/401 for RTD 2/4 wire inputs or RTD 3 wire inputs
The same procedure for configuring RTD 2/4 wire and RTD 3 wire can be followed. The only difference is when
choosing the Input Mode setting.
1. In the Input Mode column of the channel you want to configure, click the drop-down arrow and do one of the 

following:

 •  For RTD 2/4 wire input, choose RTD sensor 2/4 wires.

 •  For RTD 3 wire input, choose RTD sensor 3 wires.

2. Configure Filter Mode and Filter Cutoff for each filter tap point. (See “Defining Filter Mode and Filter Cutoff for 
Input Modes” on page 32.)
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3. Set Excitation Mode, to Current and then set the required Excitation Amplitude for your RTD (for example 
2 mA).

4. On the Linearization URL setting for that channel, click the drop-down arrow and select Add full path.
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5. Browse to the location of the thermocouple lookup files, select a file and then click Open.

6. Set the Range Maximum and Range Minimum to the required range for that RTD type; for PT_100_385 in 
this example this would be 660 ºC to -200 ºC.

To use a non-standard custom linearization file, select the custom file and its compensation channel using the User
Compensation URL and User Compensation Channel settings similar to the above.
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Configuring the AXN/ADC/401 for AC coupled inputs
1. Set the channel Input Mode to AC coupled, single ended voltage.

2. Configure Filter Mode and Filter Cutoff for each filter tap point. (See “Defining Filter Mode and Filter Cutoff for 
Input Modes” on page 32.)

3. Set the channel range to the required range for the AC coupled input.

4. Set Excitation Amplitude to 0.

Configuring the AXN/ADC/401 for ICP inputs
1. Set the channel Input Mode to ICP sensor.

2. Configure Filter Mode and Filter Cutoff for each filter tap point. (See “Defining Filter Mode and Filter Cutoff for 
Input Modes” on page 32.)
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3. Set the channel range to the required range for the ICP input.

4. Set Excitation Amplitude to 0.

NOTE:  The AXN/ADC/401 automatically supplies 3.6 mA ICP excitation current when set to ICP sensor mode.

Configuring the AXN ARINC-429 bus monitor
The AXN/ABM/401 is a 24 channel ARINC-429 bus monitor/packetizer module. 24,574 ARINC-429 word
definitions, based on Label/SDI/SSM combinations, can be defined across all channels, to cherry pick specific
ARINC-429 words of interest. The packetizer functionality is an all-bus traffic capture process, where ARINC-429
words are captured and placed into timestamped packetizer Ethernet packets as they arrive and transmitted out of
the chassis as the packet fills. Packetizer functionality into iNET-X, IENA D type, and IENA N type packetizer
formats are supported in DAS Studio 3. Packetizer packets per channel or combined, all channels into one
packetizer packet, are supported. The AXN/ABM/401 also allows you to define rules to control which words are
packetized. Rules to allow only specific words into the packetizer packets or to block specific words from being
packetized are supported.
The AXN/ABM/401 contains a number of module-level word count and status parameters.

The Word count parameters, P_MyAXN_ABM_401_ARINC-429-In(0)_WordCount, are parameters that count the
number of valid ARINC-429 words received on each channel. There is a WordCount parameter for each channel.
These are 16-bit parameters that count from 0 to 65535 and roll over back to 0.
The Report parameter, P_MyAXN_ABM_401_Report, indicates errors on ARINC-429 words received and which
bus the error was seen on. For details, see the data sheet.

The module word count, P_MyAXN_ABM_401_ModuleWordCount, is a count of all words received on all active
busses. This is a 16-bit parameter that counts from 0 to 65535 and rolls over back to 0.

The bus speed of all busses is reflected in the BusSpeedAll parameter. This parameter is available as a 32-bit
parameter, P_MyAXN_ABM_401_BusSpeedAll or two 16-bit parameters. By default, the 32-bit parameter is
available.
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To break it down into two 16-bit high and low parameters, click on the drop-down arrow and select Add new
parameter.

New parameters are created.

For details of the bus speed parameters, see the data sheet.
Indications of which busses are active can be found in the BusActiveAll parameters. This parameter is available as
a 32-bit parameter, P_MyAXN_ABM_401_BusActiveAll or two 16-bit parameters. By default the 32-bit parameter is
available.

To break it down into two 16-bit high and low parameters, click the drop-down arrow and select Add new
parameter.

New parameters are created.

For details of the bus active parameters, see the data sheet.
For debug purposes, the AXN/ABM/401 type number is available from the parameter,
P_MyAXN_ABM_401_TypeNumber.
The ARINC-429 protocol allows three bit rates: 100 kbps, 50 kbps or 12.5 kbps. The AXN/ABM/401 supports all
three in either an Auto-detect mode or User-specified mode.
To set the bus speed to auto detect the bus speed on any channel, set Rate Control to Auto-detect.
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To specify a bus speed on any bus, set Rate Control to User specified; the bit rate for that bus can be selected
from the Bit Rate drop-down menu for each bus.

The ARINC-429 protocol allows for the parity bit of the ARINC-429 word to reflect Odd or Even parity. The
AXN/ABM/401 can be configured to check each word that arrives on each bus for correct Odd or Even parity, or to
not check the parity bit. To tell the AXN/ABM/401 to check for Odd or Even parity on any bus, set Parity Check to
Odd or Even for that bus.

When parity check is enabled on any bus, any parity errors on cherry picked, specifically-defined words are
reflected in the Report word of the module. In the packetizer, the error code for parity error is set in the word info
bits to reflect any parity errors.

Packetizer setup
Packetizer packets can be configured to output packetizer packets per channel or all channels combined into one
packetizer packet. This is a module level setting. To configure individual packetizer packets per channel, set
Packetization to Individual. To configure combined packetizer packets from all channels into one packetizer
packet, set to Combined.
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Packetizer Format is currently set to iNET-X, other formats will be added as they become available.

The Max Packet Payload Size setting for each channel is the maximum number of payload bytes that can be
taken up by ARINC-429 words, plus their associated time stamps and information bits, before the packet is
considered full and the packet is closed and transmitted. This is limited to the range 200 to 511, 16-bit words. 

NOTE:  Smaller packets fill faster and generate more traffic.

The Packet Timeout is the number of milliseconds the packetizer waits for new traffic to arrive before it closes and
transmits the packet. The reason for this setting is that should the ARINC-429 input traffic stop, the module does
not wait indefinitely for a full packet before transmitting the packet. Packetizers work on a no transmit when empty
basis, in that if there is no input traffic there will be no output traffic. This setting defaults to 50 ms, but can be set in
the range 10 ms to 999 ms.

   
To enable the packetizer on any channel, select the Packetization Enabled check box for that channel.
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The Packetization Sink setting is not yet implemented. When implemented, it could be used for example, where
you have another sink module, such as a memory module, in the chassis capable of recording the packetizer
traffic. Or when transmitting packetizer traffic, using a chapter 7 encoder, and you want to restrict the packetizer to
just that module. Set to All the Packetization Sink setting puts identical packetizer traffic out of all sinks in the
chassis. Set to Controller Only, the packetizer packet is only transmitted out of the AXN/BCU/40x. Set to any
individual slot, packetizer traffic is restricted to transmitting or recording on the module in that slot. It is
recommended the Packetization Sink setting is set to All.

Configuring iNET-X Packetizers

Packetizer Format currently only supports iNET-X.

For each channel, enter a unique Stream Id. This is any valid Hex value from 0 to FFFFFFFF.
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Filtered packetizers

The AXN/ABM/401 allows you to define rules to control which words are packetized. Rules to allow only specific
words into packetizer packets or to block specific words from being packetized are supported through the
Packetizer Filter Mode settings, Block and Pass.

Packetizer filtering works by applying user-defined rules to the packetizer on each channel. 
Block means that messages that match defined filter rules are blocked and all other messages are passed
through.
Pass means that messages that match defined filter rules are passed through and all other messages are blocked.
To block specific messages from making it into the packetizer stream for that channel, and allow all others, set the
rule to Block and define rules on that channel. 
To pass specific messages into the packetizer stream for that channel, and block all others, set the rule to Pass
and define rules on that channel.
Up to 1024 packetizer filter rules can be defined per bus.

Rules for which words are allowed or blocked are covered in the rules definition section of “Cherry Picking or
parsing of specific ARINC-429 words” on page 52.

Cherry Picking or parsing of specific ARINC-429 words
24,574 ARINC-429 word definitions, based on combinations Label/SDI/SSM can be defined, across all channels,
to define specific ARINC-429 words of interest.
Refer to the following to define rules for cherry picking or parsing of specific ARINC-429 words. 
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1. On the Applications menu, click ARINC-429 Builder.

The ARINC-429 Builder dialog box opens.

2. Select one of the module channels in the left pane.
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3. To define a single message on this bus, click Add Message.

The Message name corresponds to the name of the rule used to identify this individual ARINC-429 word. This 
can be renamed by clicking on the message name and typing the new name.
The ARINC-429 label rule can be set to any valid Octal ARINC-429 value. SDI and SSM settings for this label 
can be set to All, 00, 01, 10, or 11.

4. To enable this definition as a packetizer filter rule, select the Packetizer Filter Rule Enabled check box and 
set Packetizer Filter Mode to Pass or Block.

NOTE:  Changing Packetizer Filter Mode on any message defined on a bus, applies to all messages defined 
on that bus.

Message name
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5. To add multiple messages on any bus, type the number of messages in the Add Messages field and then click 
Add Messages.

6. To remove a message definition, select the message (hold the Shift or Ctrl key to select multiple messages) 
and click Remove Message.

NOTE:  
7. This step only defines the rules to identify the ARINC-429 words. To actually read the message defined by this 

rule, you must define a parameter to be read from this message. To do this, select the message and then click 
Add Parameter. (Repeat for each message you want to define.)
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The parameter is added. Change the Parameter Name field if desired.

8. To get more information about an individual message, Tag Parameters per message can be enabled. These 
include MessageCount and time parameters. To enable Tag Parameters, select one of the parameters of a 
message and then click the Tag Parameters tab.

9. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.) 
MessageCount is the message count value for this individual instance of this message when it arrived. 
MessageIrigTime48 is a 48-bit time tag parameter; the time when this message was received on this bus. 
MessageTimeIrig48 may be broken down into MessageTimeHi, MessageTimeLo and MessageTimeMicro 
parameters. The definitions of these parameters can be found in the AXN/ABM/401 data sheet.

10. To save your rule definitions, parameters, and tags click Save & Close.
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Installing the Axonite
The Axonite (AXN/ITE/01U) and extender card (AXN/EXT/401) are transparent to the setup software and require
no configuration. (Refer to “Using the Axonite” on page 7 before connecting the Axonite.)
For example, in the following figure, a module is first installed in slot 8 of the chassis. Then the module is moved to
the Axonite—which is connected to the extender card in slot 8. In both cases, when running Discover, the software
detects the module as being installed in slot 8 of the chassis.

Figure 15: Moving module from chassis to Axonite

Setting the IP address of the AXN controller
Refer to the following to update the IP address of the AXN/BCU/40x controller module. The present IP address and
the new IP address are required to update the module.
1. On the Tools menu, click IP Address.

The IP Address Programmer dialog box opens.

This tool supports reprogramming IP addresses across the entire range of Acra KAM-500, switches and AXN 
products by selecting the corresponding protocol. For AXN, select Axon Family Chassis from the Protocol 
drop-down list.

Move AXN/ADC/401 from slot 
8 of chassis to Axonite

Install AXN/EXT/401 
in slot 8

Connect 
AXN/CAB/001/01M from 
extender card to Axonite
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2. Type the current IP address of the AXN/BCU/40x in the Present IP Address field. 

3. Type the new IP address in the New IP Address field and then click Program.

NOTE:  Changing IP address to a different IP subnet may cause verification issues until the subnet of the PCis 
changed to match. (for example, if 192.168.28.1 changes to 192.10.45.56, the PC must move to the 
192.10.45.XX subnet)

IP Address Programmer does not automatically update the IP address in the task file; this must be 
updated manually. Failure to update the IP address in the task file to match IP address in the module 
will cause programming failures.

Creating packets and sampling data
Now that the AXN modules and backplane controller configured, the next step is to create packets to sample data.
1. In the Navigator, expand the AXN/BCU/40x node and the Outputs node.

2. Select Ethernet(1) and then click the Packages tab.
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3. Select Ethernet(1) in the Channels pane.

4. Click the Import Package button in the Package Properties pane. 
Packages Palette opens.

5. Select the iNET-X tab and choose MyPlacediNET-XPackage and then click Add.
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The package is added to the Package Properties pane..

Rename the package if required.
Set Stream ID to the required value (it must be a unique Hex value between 0 and FFFFFFFF). 
Source IPA should match the IP address of the AXN/BCU/40x. 
Source UDP Port is editable. 
Destination MAC is automatically calculated based on Destination IPA address for multicast IP. 
Making the Destination IPA address Unicast enables editing of the Destination MAC. 
Destination UDP port is editable.

The Rate setting for the package is the most important setting. All parameters placed in this packet are 
sampled at this rate multiplied by the number of samples in the packet. For example, a parameter placed once 
in a 10-Hz packet is sampled once at 10-Hz intervals. A parameter placed four times in a 10-Hz packet is 
sampled at 40 Hz. 

When multiple packets are defined the acquisition cycle of the chassis is based on the slowest packet out of 
the AXN/BCU/40x.
For example: 
If two packets are defined, both at 10 Hz, the acquisition cycle is 10 Hz; each parameter in each packet is 
sampled at the start of the acquisition cycle and any parameters sampled more than once in any packet are 
sampled at even intervals throughout the 10-Hz cycle.
If two packets are defined, one at 1 Hz and one at 10 Hz, the acquisition cycle is 1 Hz with the 10-Hz packet 
and its contents are sampled 10 times in the 1-Hz cycle. Each parameter in each packet is sampled at the start 
of the acquisition cycle and any parameters sampled more than once in any packet are sampled at even 
intervals throughout the 1-Hz cycle.

For packet rates that do not divide evenly into each other, such as 3 Hz or 7 Hz, the acquisition cycle is the 
highest common factor of both rates.

6. To define the contents of a packet, select the package in the Package Properties pane.

7. Then in the Placed Data pane, click the Place Parameter button.

Parameters Palette opens.
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The palette lists all parameters available to the AXN/BCU/40x from all modules in the chassis. 
By clicking the filter icon on any column, you can filter to see parameters available from a specific module, 
channel or message.

8. Select the parameters you want and click Add Reference.

The parameters are added to the package and can be viewed in the Content and Placed Data panes.
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The Placed Data pane shows the parameter name, the number of occurrences or samples in this packet, the 
parameters size in bits, the Source Chassis, Source Instrument, and Source Channel on that instrument. 
Actual Rate is the package rate multiplied by the number of occurrences. To change the Actual Rate setting of 
one parameter, edit Occurrences for that parameter; Actual Rate automatically changes to match.

Changing the Rate setting in Package Properties update the rate on all parameters in that package.

Verifying the task file
Use this tool to verify that the data throughput and sequencing specified in the configuration can be achieved.
1. On the Quick Access Toolbar or the Tools menu, click Verify.

The tool verifies that the desired data throughput and sequencing requirements can be realized on the 
available instrumentation. 
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Then a message box is displayed reporting if verification passed or failed.

 

2. Do one of the following:

 •  If the verification step succeeds, click OK; the instrumentation is ready to be programmed. 

 •  If the verification step fails, double-click the icon to open the Message Server dialog box and locate the 
error(s) shown in red text.

Packetizer packets are automatically generated by the software during verification. The AXN/BCU/40x 
Ethernet port on the packages tab now shows packages added for each enabled packetizer channel.

The package name is based on the module name and the Stream ID for that packetizer channel. The rate is 
automatically calculated based on the bit rate set on the channel. 

Programming instrumentation
1. Ensure the hardware you are programming is connected and powered on.
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On the Tools menu, click Program.

The tool verifies that the desired data throughput and sequencing requirements can be realized on the available 
instrumentation and programs the connected hardware. 

If verification fails, programming is not performed and error messages are shown. A message box is displayed 
reporting if programming passed or failed. 

2. Do one of the following:

 •  If programming succeeds, click OK.

 •  If programming fails, double-click the icon to open the Message Server dialog box and locate the error(s) 
shown in red text.
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Real time viewing of data
DAS Studio 3 creates XidML 3.0 files in the default installation folder C:\ACRA\DASStudio\3.X. The XidML file can
be used as your input file for Quicklook real-time data visualization software.
Refer to the following to use Quicklook to view and analyze XidML configuration files from DAS Studio 3.
1. Launch Quicklook from the start menu.

2. Set the Data Source to Acra (IENA or iNETX) and then click Next.

3. Click Next.
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4. Select the All Packages radio button and then click Next.

5. In the Network Interface drop-down menu, select Ethernet and then click Test Connection. 

6. If three green lights are indicated, click Next.

7. Select the Create a new Config file radio button and then click Finish.
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8. Build screens to view your data. (Refer to Quicklook online help for further information.)

Balancing analog channels using Bridge Balancer
On the Tools menu of DAS Studio 3 software, click Bridge Balancer.
The Bridge Balancer dialog box opens. See Chapter 10 of the DAS Studio 3 User Manual for further steps.
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